
Chemistry/MatSci 5223W Thursday, January 26- 
 Thursday, February 2 
 

Lab 2 
Statistical Copolymers via Free-Radical Copolymerization 

Report Due: In Lecture, Wednesday, February 15 
Report Revision Due: In Lecture, Wednesday, March 1 

 
 
 
Introduction 
 
Copolymerization of multiple monomers allows for the synthesis of new polymeric materials with 
properties that are often substantially different from homopolymers made from the individual 
monomers.  This experiment will allow you to perform the radical copolymerization of styrene 
and methylmethacrylate and determine the relative reactivities of these monomers in this process. 
As in Lab 1, polymerizations will be initiated via the thermal decomposition of benzoyl peroxide 
to benzoyl radicals. You will also learn to characterize polymers by nuclear magnetic resonance 
(NMR) spectroscopy. 
 
As early as the 1930’s it was recognized that in the polymerization of equimolar mixtures of two 
different monomers, the tendencies of the monomers to incorporate into the growing chain will 
differ.  The result of the variable incorporation of monomer is that the composition of the feed 
(and thus the copolymer) will change as the polymerization proceeds.  Variable monomer 
incorporation arises from selectivity of monomer addition at the growing chain end. The 
copolymerization of monomers M1 and M2 can give rise to four different propagation 
opportunities (Figure 2-1): 
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Figure 2-1. 
 
Here, k11 and k22 are the rate constants for self-propagation, and k12 and k21 are the rate constants 
for cross-propagation.  The relative reactivity ratios for M1 and M2 in this polymerization can be 
described as r1 = (k11/k12) and r2 = (k22/k21), respectively.    
 
The rate of consumption of M1 initially can be described by: 
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And of M2: 
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The consumption of M1 and M2 is due to their incorporation into the growing copolymer.  The 
ratio of monomer incorporation into the copolymer employing the steady state approximation can 
thus be given by the ratio of the two monomer rates as per the instantaneous copolymerization 
equation: 
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If the monomer feed concentrations of M1 and M2 (mole fractions) are denoted f1 and f2, and the 
mole fraction of these monomers that are incorporated into the copolymer as F1 and F2, the 
instantaneous copolymerization equation can be defined for F1: 
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Experimentally, reactivity ratios are often determined by performing a series of polymerizations 
under identical experimental conditions, but beginning each polymerization at different 
concentrations of the two monomers.  The polymerizations are terminated at low conversion (3-
10%), and the resulting polymer is characterized to determine the levels of incorporation of the 
two monomers (F1 and F2).  
 
A variety of methods have been devised for extracting r1 and r2 from copolymer feed (fn) and 
composition (Fn) data. In the days before computerized data analysis, Fineman and Ross1 and 
Kelen and Tudos2 developed forced linearization methods for dealing with the complexity of 
equation 2.4. Today, non-linear least-squares curve-fitting programs (such as Kaleidagraph) allow 
for the determination of r1 and r2 without resorting to a forced linearization protocol.3 Values for 
r1 and r2 can be obtained by a form of the instantaneous copolymerization equation given in terms 
of f1 and F1 by substituting (1 - f1) for f2 in equation 2.4: 
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In this case, the data of a plot of f1 vs. F1 can be analytically fit to equation 2.5 to obtain values 
for r1 and r2. 
 

                                                           
1 Fineman, M.; Ross, S.D. J. Polym. Sci., 1950, 5, 259. 
2 Kelen, T.; Tüdös, F. J. Macromol. Sci.-Chem., 1975, A9, 1. 
3 For a more detailed discussion, including references on how to implement this fit, see: (a) Bauduin, G.; 
Boutevin, B.; Belbachir, M.; Meghabar, R. Macromolecules 1995, 28, 1750, and references therein. (b) G. 
Odian, Principles of Polymerization, pp. 467-470. 



Experimental 
 
Bulk copolymerization of styrene and n-butylmethacrylate (Jan 26/27) 
 
The goal of this experiment is to observe the consequence of copolymer ratio on the physical 
properties of a copolymer material. 
 
• In a 6” test tube, pour a total of 5 mL of styrene and n-butylmethacrylate; feel free to choose 

any ratio of the two monomers, though styrene content between 5 and 25 wt% will give you a 
nice spectrum of plastic flexibility. Add 0.05 g of benzoyl peroxide, and swirl to dissolve. 
Follow the instructions in Lab 1 for spraying an aluminum pan with silicone mold release and 
polymerizing the mixture in the 70 °C oven. 

• Next week: Remove your polymerized sample from the aluminum pan. How does this sample 
compare with the homopolymers from Lab 1? 

 
Copolymerization of styrene and methylmethacrylate (Jan 26/27) 
 
The goal of this experiment is to copolymerize styrene and methyl methacrylate using a free 
radical initiator, and determine reactivity ratios for the resulting copolymers. 
 
• In three separate 6” test tubes, put 5 mL (total) of a styrene-methyl methacrylate monomer 

mixture.  Use the ratios of styrene to methylmethacrylate that were listed in your pre-lab 
handout. Add 0.1 g of benzoyl peroxide to each of the tubes and swirl to dissolve.  Repeat the 
procedure outlined for the test-tube styrene polymerization performed in Lab 1.  Make sure to 
record the polymerization time and temperature, and dry your product in the vacuum oven as 
you did with the styrene homopolymer. 

 
NMR analysis of copolymer ratios (Feb 2/3) 
 
• Determine the mass yield of your samples. If the yield is greater than 10%, or you isolate less 

than 150 mg of polymer (about 3%), you should disregard the data from that polymerization 
run. 

• Check out three NMR tubes from the stockroom. Put approximately 25 mg of each of your 
polymer samples into a small vial along with about 1 mL of CDCl3 to dissolve, and allow to 
sit for about 30 minutes to fully dissolve. Then, transfer each solution to an NMR tube. 
CDCl3 is very expensive, so don’t spill or waste it. Put your samples in the class NMR tube 
rack, and label each tube with your group number and the fraction of styrene (fstyrene) 
monomer you used. (For those of you familiar with taking NMR spectra of organic samples, 
25 mg will seem like too much material. However, because peaks in NMR spectra of 
polymers tend to be broad, you’ll need more than you’re used to.) 

 
Your NMR spectra for this class will be acquired by the TA’s in the Chemistry Department NMR 
Facility, but you will be expected to work up the data yourself. Raw FID’s will be available for 
processing in the data directories of the Polymer Lab NMR account. Each FID file will be titled 
according to the date and time it was acquired; a listing of which files are yours will be posted on 
the “Data” page of the course website. 
 



These instructions will guide you through using either the workstations in the NMR Lab 
(S166/S168 Kolthoff; M-F 9 am–5 pm) or in the Microcomputer Lab (176 Kolthoff; M-Th 9 am – 
9 pm, F 9 am – 5 pm, Sa 11 am – 4 pm) to work up NMR data. You may alternately choose to 
download, install and use KnowItAll (http://www.knowitall.com/academic/welcome.html, from 
Bio-Rad) or MestRe-C (http://qobrue.usc.es/, from the Universidade de Santiago de Compostela), 
free NMR analysis software available for your home PC to analyze Varian UNITY NMR data 
that you have saved on Zip disk. We cannot help you with the use of these software packages. If 
you are interested in this option, please see the “Advanced 1D NMR Instructions” online 
(http://nmr.chem.umn.edu/advanced1D.pdf) to learn how to save your FID to Zip disk. 
 
• If you are using a PC in the Microcomputer Lab: 

o From the Start Menu, open Programs → Internet Tools → XWin32 5.4 → X-Win32 5.4. 

o In the Connect Method box that follows, press “Cancel”. 

o Unfortunately, XWin32 hides the Taskbar. To bring it back, press the Windows key 
(between Ctrl and Alt). In the Start Menu, select “Run…”. Type “telnet”. 

o At the prompt that pops up, type “open echo.chem.umn.edu”. Then, at the next prompt, 
log in as user name zzzlab, password poly.lab. Wait a moment for the X-Windows 
program to load the vnmr interface. You can minimize the telnet client while you work, 
but don’t close it. 

• If you are using a workstation in the NMR Lab: log in with username zzzlab and password 
poly.lab. 

• Loading the FID. In the button bar at the top of the vnmr program, select [Main Menu] - 
[File] - [VAC-300]. (Your spectra for this lab will be collected on the autosampler 300 MHz 
instrument.) You will see a list of FID datasets. Click on the filename of your dataset to 
highlight it and select [Load FID]. 

It is possible that the software will report an error, “cannot read and copy text file,” when you 
try to load your dataset. If this happens, it is probably because someone is working on files in 
the same “experiment space” you are. When you first log in, you are automatically placed in 
experiment space #1, but there are a total of 9 experiment spaces available. To change spaces, 
type the command “jexp2”, “jexp3”, or whatever number corresponds to whatever space you 
would like, and try loading your FID again. 

• Fourier transform. Type wft to weight and Fourier transform the FID, or select [Main 
Menu] - [Process] - [Weight, Transform]. Your NMR spectrum should automatically be 
displayed; if not, select [Main Menu] - [Display] - [Interactive]. 

• Mouse controls. At this point, you may want to play with some of the mouse controls. The 
left and right mouse buttons control the red vertical cursors. Your middle mouse button (if 
you have one) controls vertical scale of spectrum (vs) or integral scale (is), if the integral is 
displayed. At the bottom of the screen you’ll see three abbreviations and indices of what your 
three mouse buttons do. If at any point you would rather control these values numerically 
rather than with the mouse, type the value into the command box. (E.g., typing vs = 20 would 
substitute for operating the middle mouse button.) 

• [Cursor]/[Box] buttons toggle between 1 and 2 vertical cursors. 

• Zooming in. [Expand]/[Full] buttons allows you to zoom in to the region between two 
vertical cursors, and then back out to the full spectrum. Having the spectrum cover the 9.5 to 
-0.5 ppm region works well. To set this region, you can work those cursors, or you can type 



cr = 9.5p, delta = 10p, [Expand]. (The “p” refers to ppm; if you omit it, the software will 
interpret your number in Hz.) 

• Phasing. Look at the baseline of your spectrum—does it look sloped, or otherwise funny? 
You can improve your baseline by “phasing” your spectrum. 

o To do this automatically, type aph. This usually works. 

o If not, to phase manually, select [Phase], and click-and-drag the left and right mouse 
buttons to phase two different areas on your spectrum. The computer will 
interpolate/extrapolate your phasing to the rest of the spectrum. 

o Select [Box]/[Cursor] to get out of phase mode. 

o If you get lost and really screw up the phasing, you can always go back to your original 
spectrum by autophasing again (aph). 

• Referencing. The ppm scale in your spectrum should be referenced either against CHCl3 (δ = 
7.26 ppm) or (CH3)4Si (TMS, δ = 0 ppm). Find one of these reference peaks and move the 
cursor on top of it. If the ppm value is incorrect, type nl to move to the top of the nearest line. 
Then type rl(7.26p) or rl(0p), or select [Ref] and give the appropriate ppm value when 
prompted. 

• Integration. In all likelihood, if your spectrum already shows integration regions that have 
been selected by the computer, it will have done a poor job. To do a better job yourself:  

o Select [Int] to display the integral trace (green line). 

o Then select [resets] to start integral reset mode. Integrated regions will show up as a solid 
green line, and non-integrated regions as a dotted line. 

o To clear all the reset points (where the integration regions begin and end), type cz; the 
whole integral line will turn solid green. 

o To set new reset points, click with the left mouse button on the left side of a peak to start 
the integral, and again on the right side of the peak to end it. Try not to make your 
integral areas too broad or too narrow. 

o Click with the right mouse button to remove the nearest integral reset. (Say, the one you 
just made that you don’t like so much.) 

o Select [Box]/[Cursor] to get out of integral reset mode. 

• Peak picking. If your peaks are sharp, they can be labeled in the printout by setting the 
threshold for peak picking. 

o Select the [Th] button to display the yellow horizontal threshold line. Peaks that rise 
above this line will be marked. 

o Use the left mouse button to drag the yellow line to a new level. 

o Select [Th] again to get out of threshold adjustment mode. 

• Plotting to paper. 

o Set the plotter to your local printer by selecting [Main Menu], and then repeatedly select 
[Change Plotter] until your appropriate printer name is diplayed. Printer names: 

 S166/S168 Kolthoff (NMR Lab) — ‘LaserJet_300R’. Your spectra will print on the 
printer in the back half of the facility without the robotic autosamplers. 



 176 Kolthoff (Microcomputer Lab) — ‘microchem_lefty’ or ‘microchem_righty’. 
Your spectra will print on the appropriate HP printer. 

o Type text(‘title of plot’) to give your spectrum a title. Make sure you type the single 
quotes. 

o Either type plot to print your whole spectrum automatically, or type pl pscale ppa ppf 
pir pltext page to print your spectrum (pl), the scale (pscale), the spectrometer 
parameters (ppa), the picked peak labels (ppf), the integral regions (pir), the text label 
(pltext), and to send everything you chose to the printer (page). If you want to omit any 
of these items, don’t include the command in the list. (Except page, of course.) 

• Plotting to a postscript file (for inserting spectra into a lab report). 

o Set the plotter to plot to postscript by selecting [Change Plotter], as you did above, until 
‘PS-AR’ (the postscript “printer” name) is diplayed. 

o Change the working directory by selecting [Main Menu], [File], [DATA]. This is the only 
directory that you have external write-access to, so you must be in this directory. 

o Type the sequence of commands listed above (pl pscale ppa ppf pir pltext), followed by 
page(‘filename.ps’) instead of page. Please choose a filename that you will recognize 
clearly, because the whole class will be saving files in the same place. 

• Log off. Type exit or select [Exit VNMR] to close the vnmr software. 

• If you are using a PC in the Microcomputer Lab: Press the Windows key to bring back the 
Taskbar; right-click on XWin32 in the Taskbar and select “Close”. Also right-click on your 
telnet session in the Taskbar and select “Close”. 

• Transferring postscript files to PC (Microcomputer Lab only). 

o Make sure you have removable media (CD-R, DVD-R, or USB drive) to save your files 
to, or that you know how to use transfer files via a web e-mail client. 

o From the Start Menu, open Programs → Internet Tools → FileZilla → FileZilla v2.217a. 

o At the top of the FileZilla window, input the NMR server Address (echo.chem.umn.edu), 
User (zzzlab), and Password (poly.lab). Press the Quickconnect button. 

o The FileZilla window has a split view; folders on the local computer are shown on the 
left, and folders on the remote (NMR server) computer are shown on the right. On the 
right, double-click the “data” directory to open it. 

o Find your filename.ps file, and drag it over to a destination on the left. If you are using a 
USB drive, or have inserted a CD-R or DVD-R, drag directly onto the appropriate drive 
letter. If you want to save temporarily to the local computer, drag the file to the “Z:” 
drive (which corresponds to the ‘Everyone’ folder on the desktop). 

o Postscript files can be manipulated by a number of programs, including Adobe Acrobat 
(but not Acrobat Reader), many drawing applications (Adobe Illustrator, CorelDraw), 
and Ghostscript. Adobe Acrobat is available in the Microcomputer Lab, and can convert 
your postscript spectrum to PDF or image (JPEG, TIFF) formats. 

Alternately, you could scan your paper spectra on a flatbed scanner. (The Microcomputer Lab 
has one.) I think you’ll find that, because NMR spectra have both lots of small details and lots 
of whitespace, to scan them you’ll have to choose between generating extremely large files or 
unreadably low resolution. I recommend the postscript route. 



 
If you have any further questions about manipulating or plotting your NMR spectra, refer to the 
NMR Facility’s online instruction manuals at the facility’s website (http://nmr.chem.umn.edu/). 
 
You should use the integrations you performed on the NMR spectra to determine F1 and F2 for 
your copolymer samples. Remember to factor in the number of protons that contribute to each 
NMR peak(s) per molecule. As part of an Assignment, you will be expected to post your data to 
the course WebCT Discussion Board. 

Lab Report (due in lecture, Wednesday, February 15) 
 
Prepare a lab report titled, “Determination of reactivity ratios in the free radical polymerization of 
styrene and methylmethacrylate.” Using nonlinear least-squares fitting to Equation 2.5, calculate 
r1 and r2 from the class’ f1 and F1 data for the copolymerization of styrene and 
methylmethacrylate. You can use Kaleidagraph, a program available in the Microcomputer Lab, 
to do this. Instructions on how to use this software package are at the end of this handout. 
 
The report should be single-spaced, and any figures, tables or graphs should be inserted in the 
text. Your report should be structured like a journal article in an American Chemical Society 
journal (such as Macromolecules), like the one you examined as part of Assignment 4. As you did 
in that assignment, you may want to consult websites or articles on how to write a scientific 
paper. 
 
Please be concise in your writing. Be sure to list the names of all of your group members as 
coauthors; as the corresponding author, your name should be designated with a *. At any point, if 
you wonder how to structure or phrase something, look at a couple of Macromolecules papers and 
copy their format. 
 
Overall, your report should stand on its own, independent of this course. If a reader from another 
university with no knowledge of your assignment were to read your report, would they 
understand it? If not, you need to explain better. Explain your purpose. Explain your graph. 
Explain your conclusions. 
 
Your report should contain the following sections: 
 
Introduction. Discuss the goals of your kinetic analysis. Give background on copolymer kinetic 
analysis here, including a brief discussion of the fitting technique you plan to use. Other than to 
satisfy the requirements of this class, what was the aim of this experiment? (Why would anyone 
want to know reactivity ratios?) Give a background for the experiment by (1) discussing any 
theoretical issues required to understand the lab and (2) describing why the experiment might be 
important. If you write about something you learned from somewhere else, reference your source; 
however, as in journal articles, reference materials that a reader can access (e.g., other journal 
articles, textbooks, handbooks) rather than materials that others don’t have access to (e.g., my 
lectures, your lab instructions). Chemical structures of your molecules, if you would like to 
include them, can go here as well. 
 
It will be tempting for you to copy the Introduction of the lab instructions into the Introduction of 
your manuscript. They serve different purposes, and your Introduction should be more concise 
and general than mine anyway. So don’t do this. 
 



Experimental. How did you do the experiment? Your description should allow someone who has 
never met you or read the assignment to reproduce your work. Omit parts that don’t help this 
imaginary person. (Example: “The aluminum pan was labeled with our names.” Your imaginary 
experimenter will probably succeed if he labels the pan something else.) But include parts that 
might be important. (Example: “The sample was placed in an aluminum pan and dried in a 
vacuum oven for 2 days.” What if the experimenter used something else other than aluminum? 
Heat might not transfer as well, flat shape might be important to effective curing….) As in the 
Experimental sections of ACS journal articles, your Experimental should be written in the third 
person past-tense. 
 
Be as numerical as you can be here. Always report precisely what you did (“0.05 g (0.2 mmol) 
benzoyl peroxide was added”) rather than what you calculated (“one molar equivalent of benzoyl 
peroxide was added”). In addition, be descriptive about what happened in lab. If your reaction 
turned blue, write that. If you departed from the written procedure, write that. It may be tempting 
for you to edit my lab instructions directly into your experimental; because my instructions 
include details that are helpful, but not really critical, you should resist this temptation and write 
your experimental from your lab notebook in your own words. 
 
Results and Discussion. What were the results of your experiments? What did they demonstrate? 
Was your hypothesis proven? In this section, you should include: 
 

• A discussion of what you did and what data you (and the class) collected. 
• Any equations you need to explain your analyses. 
• An example NMR spectrum with integrations, illustrating how you determined f values. 
• The appropriate graph for determining r1 and r2, (be sure to include a figure caption). 
• The calculated values of r1 and r2. 
• A one-paragraph discussion of your results with a comparison to literature values. What 

are the sources of the error you estimated? 
 
I have asked for the Results and Discussion sections together because Macromolecules does. This 
means you should present your data and discuss it at the same time. Figures should have Figure 
Captions that describe the Figure and explain any peculiar notation. (If you are using Microsoft 
Word, you can format these automatically by selecting your Figure, and then choosing Insert -> 
Reference -> Caption.) If there are any sources of error that would explain why your data doesn’t 
work the way you expected, you should include that here. 
 
References. You may format your references as either footnotes or endnotes. In either case, the 
in-text reference number should be a superscript number. Make sure references are in ACS 
format: (Authors Journal, Year, Volume, Page) for journal articles; see the ACS Style Guide for 
other sources such as books. 
 
Some resources on what the different sections of a research paper should look like are listed on 
the course website, on the “Links” webpage. A few tips: 
 
• You will want to become familiar with Equation Editor (included in Microsoft Word) or 

another equation formatting tool (such as MathType Lite, free on the web) for your reports. 
It's pretty difficult to format complex equations on one line, and copying equations from my 
lab instructions won't format very well in your document. Help with these tools is available in 
Word or on the web. 

• Same is true for ChemDraw or ISISDraw. The latter is a free download. 



• Same is true for subscripts and superscripts. Most programs have a "Format" -> "Font" type 
option that will allow you to do these formats. 

• Variables, and most constants, are italicized. Look at a textbook, or the ACS Style Guide, if 
you are unsure about whether to italicize something. 

• Numbers and units are always separated by a space. ("10 mL" rather than "10mL".) So are 
math functions. ("r = 1", not "r=1".) 

• Your Experimental should be very specific. Don't make your reader calculate anything; say 
exactly how much of things you used, how you interpreted data, make sure significant figures 
are roughly correct. ("Five milliliters" means EXACTLY five milliliters. "5 mL" means 5 +/- 
1 mL, and I think you can measure more accurately than that. "5.0 mL" would probably be 
appropriate.) 

• Do not reference my lab instructions. You will find everything that is in them in textbooks 
and in the papers I cite. Reference these instead. 

 

Revised Lab Report (due in lecture, Wednesday, March 1) 
 
You will have the opportunity to revise your report after we grade it the first time. You will be 
able to recover up to half of the maximum points for the lab report. (So if you received 70/100 on 
the first grade, your revision could net you 100/100; but if you received 40/100, your revision 
could earn you a maximum of 90/100.) We will hand back your report in lab on February 16/17, 
with corrections to be made. You are particular encouraged to meet with Andy Taton in his office 
(Kolthoff 455) immediately after lab to talk specifically about what you might improve in this 
report. 
 



Chemistry/MatSci 5223W 
 

Lab 2 Appendix 
Nonlinear Least-Squares Curve Fitting with Kaleidagraph 

 
 
If you would like to try to fit your (f, F) data directly to the copolymerization equation, you might 
use Synergy Kaleidagraph. (You can also do nonlinear least-squares fitting on Microcal Origin, 
Mathworks MATLAB, or Wolfram Mathematica, if you have access to them and know how to 
use them. It is also possible to use Excel’s “Solver” functionality to do nonlinear least-squares 
fitting, but it is complicated, and I recommend against it.) Kaleidagraph is easy to use, but you 
will have to go to the Microcomputer Lab (176 Kolthoff) to use it. 
 
To use Kaleidagraph for nonlinear least-squares fitting: 
 
1.  Open Kaleidagraph and click File, Import, Excel to import data from an Excel spreadsheet. 
 
2. Graph your data by clicking Gallery, Linear, Scatter. Pick the appropriate columns for the 

x- and y-axes, and create a New Plot. 
 
3. To fit any of your data to a custom function, click Curve Fit, General, fit1. (Fit1 is already 

defined, but we will change it. If you want to create and save functions rather than just editing 
the one in the program, click Curve Fit, General, Edit General and create new functions.) 

 
4. Check the data box you want to fit. Then, click Define to create your function. The function 

has to have a specific form in which the independent, x-axis variable (e.g., f) is named “m0” 
and all other variables to be optimized are named “m1”, “m2”, etc. The equation is then 
followed by initial guesses for the optimized variables. So, for example, if you were graphing 
(f, F) data and you wanted to fit it to the equation 
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 you might type 
 

(m1*(m0)^2 + m0*(1-m0))/(m1*(m0)^2 + 2*m0*(1-m0) + m2*(1-m0)^2); 
m1 = 1; m2 = 1 

 
 in the function box. In this equation, the “F1 =” part doesn’t show up, m0 stands for f1, m1 for 

r1, and m2 for r2. You also need to input initial guesses at the end for m1 and m2; here I’ve 
guessed 1 for both. Importantly, none of your initial guesses can be set to a value of 0, or you 
will get an error. The program will turn your guesses into optimized, fit values for m1 and 
m2. 

 
5. Click OK, and a fit curve should appear in your data window, along with the optimized 

values and other information from your fit. If you don’t like your fit, you can remove it from 
the graph by going back into Curve Fit, General, fit1 and deselecting the check box for the 
fitted data. Click OK, and the fit curve and fit data disappear. (This way, if you made a 
mistake in the equation, you can go back and re-fit onto the same data.) If you get a “Singular 



Coefficient Matrix” error during your fit, it is probably because your initial guesses were 
really far off; try new guess values. 


